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1 NYCe 4000 LMS Tools
1.1 Introduction

This manual provides information how to configure an LMS.
● chapter 2  "System configuration" on page 3

This chapter describes the steps you must do whether your LMS
application is executed on a PC or on an LMS node.

● chapter 3  "Carrier Position Adjustment (CPA) tool" on page 9
The Carrier Position Adjustment tool is a tool to generate the so-called
CPA tables. The actual position of carriers can be improved if the CPA
functionality is enabled in an LMS configuration and CPA tables are
available. These CPA tables are generated using an external
measurement system.

● chapter 4  "NYCeCmMonitor" on page 25
The NYCeCmMonitor tool gives you a quick overview of the status of
the LMS, such as the system state, tracks and carriers in the LMS.

 
General information of the LMS can be found in the LMS User Manual.

LMS sensor This manual uses the term "LMS sensor" for the sensor that is used in an
LMS to detect the position of a carrier. The LMS sensor can be based on two
different technologies. One technology uses two Hall sensor elements, the
other technology uses two magneto-resistive sensor elements. The term
"LMS sensor" is used when a general reference can be made, "Hall sensor"
and "MR sensor" is used when a specific reference must be used.
The dialog screens shown in this manual may slightly differ from the actual
displayed windows on the screen.

1.2 General remark on XML formatted files
The NYCe 4000 tools and software API functions read and write XML
formatted files on the host. You can also modify these XML (configuration)
files with a suitable (XML) editor. If you do not use the NYCe 4000 tools, but
use an external editor to modify an XML formatted file, make sure that the file
is saved ANSI encoded. If the file is saved with a byte order mask (for
example a UTF-8 byte order mask), the NYCe 4000 tools and API functions
report the error SAC_ERR_OPEN_FILE_ERROR when such a file is opened.
The folder "xmlnotepad" on the NYCe 4000 DVD contains a supported XML
editor. Further, make sure that the information that you add manually in an
XML file is correct. Invalid information in an XML file may generate error
messages or cause unexpected behavior.

1.3 Used abbreviations in this manual
The following table gives a summary of abbreviations used in this manual.

Abbreviation Description

CPA Carrier Position Adjustment

Hall sensor A sensor based on two Hall elements

IEEE Institute of Electrical and Electronics Engineers

LMS Linear Motion System
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Abbreviation Description

MCU Motion Control Unit

MR sensor A sensor based on two magneto-resistive (MR) elements

NHI Node Hardware Interface (subsystem)

NY4114 MCU module with 3 IEEE 802.3 interfaces

NY4120 PWM Drive Module

NY4120/10 PWM Drive Module for LMS

NY4150 SERCOS III Master Module

pu Position unit (user-defined dimension of position)

PVL Position Velocity Loop

Tab. 1-1: Summary of used abbreviations
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2 System configuration
2.1 Introduction

An LMS consists of two major parts, the LMS application which is developed
by the user and the LMS Carrier Management (CM) software which is part of
the NYCe 4000 LMS product. The LMS application can be executed
● as a program on a Windows-based PC.

A Windows-based PC is required in the NYCe 4000 network and the
NYCe 4000 software must be installed on that PC. CM can be active on
the PC or on any LMS node.

Windows-based

NYCe 4000 software

NYCe 4000 LMS 
node(s)

LMS firmware

Carrier Management

PC

LMS application

Fig. 2-1: LMS application on a PC
 

● as a program executed on a PLC.
A Windows-based PC in the NYCe 4000 network and NYCe 4000
software installed on that PC is optional. If the PC is not used Carrier
Management must be active on one LMS node.

PLC
Windows-based

NYCe 4000 software

NYCe 4000 LMS 
node(s)

LMS firmware

Carrier Management

LMS application

PC

(optional)

Fig. 2-2: LMS application on a PLC
 

● as an Embedded Application on an LMS node.
A Windows-based PC is no longer needed, Carrier Management is
executed on one LMS node.

NYCe 4000 LMS 
node(s)

LMS firmware

LMS application
Embedded Application

Carrier Management

Fig. 2-3: LMS application on an LMS node
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The LMS CM provides the CM functionality API for the LMS application, CM
service for LMS control, and CM socket server for CM application execution
on a separate PLC or PC.

Start-up of the LMS application, regardless where the application
executes, is significantly improved when the LMS configuration
file (lms.xml) and axis (coil) configuration file(s) are stored in
flash memory on the node, and have "UseFlash" specified in the
LMS configuration file. You only have to do the following actions
once.
● Start NYCeConfigurator.
● Initialize the system from file.
● Save the configuration to flash memory on the node.

2.2 CM on the PC
Traditionally, a NYCe 4000 LMS consists of one or more NYCe 4000 LMS
nodes and a PC. On the PC runs the CM service and the CM socket server.
The LMS application can run on the same PC or on a PLC. If the LMS
application runs on a PLC, the CM socket server is needed.

NYCe 4000 libraries

CM libraries
n4kcm.dll    n4kcmc.dll    n4kcmextension.dll

PC

NYCe 4000 node

NY4114

PLC
CM application

CM libraries
n4kcmapi.library
n4kcmcapi.library

n4kcmsocketclient.library

CM  application CM serviceCM socket server

Fig. 2-4: CM (service and socket server) on the PC
 

2.3 CM on a node
The LMS node has the NY4114 MCU which executes the Linux operating
system. As such, the MCU offers the possibility to run the LMS application on
a node as an Embedded Application. In this configuration the PC is no longer
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required by the LMS application. The CM service and CM socket server are
moved from the PC to any LMS node and are executed as daemon
processes. For brevity, when "CM service" is mentioned, CM socket server is
included, unless explicitly mentioned otherwise.

NYCe 4000 libraries

CM libraries
libn4kcm.so   libn4kcmc.so   libn4kcmextension.so

CM
Embedded Application

NY4114

CM serviceCM socket server

NYCe 4000 node

PLC PC
CM application CM application

CM libraries
n4kcmapi.library

n4kcmcapi.library
n4kcmsocketclient.library

socket client
(developed by customer)

Fig. 2-5: CM (service and socket server daemon) on the node
 

Restrictions The following restrictions apply when CM service is active on a node.
● LMS Commissioning Tool is not supported.
● Event enrolment and redirection of logging is only supported on the

node where CM service is active. If an LMS application requires event
enrolment or redirection of logging, the LMS application must be
executed on the same device where CM service is active.

● Multiple instances of NYCeLogger are not supported. NYCe 4000 log
information can be retrieved from only one device.

● It is not possible to distinguish which LMS application calls a log
function. The change of logging settings applies for all LMS applications.

● CM service and CM socket server are two separate daemon processes
that run on one node.

A Windows-based PC in the NYCe 4000 network with NYCe 4000
software LMS installed on that PC is still needed for any LMS
configuration definitions, because the NYCe 4000 (LMS) tools
only run on a Windows-based PC. LMS Commissioning Tool
requires that CM service is active on the PC.

2.4 Configuration
2.4.1 Introduction

When the CM application is executed as an Embedded Application on a node
or the CM application is executed as a program on a PC, CM service can be
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active either on any LMS node or on the PC. When the NYCe 4000 (LMS)
tools are needed, a PC is required to run the tools, but CM service can be
active either on the PC or on any LMS node. However, the LMS
Commissioning Tool requires that CM service is active on the PC.

2.4.2 Starting and stopping CM service
When NYCe 4000 LMS is installed, CM service is activated on the PC by
default. CM socket server must be manually started. You can change the
location where CM service is activated. When CM service and CM socket
server are activated on a node, both start automatically. No restart of the PC
or node(s) is needed when CM service is moved from PC to a node or vice
versa to effectuate the new configuration.
The following options are available to change the location of CM service.
● NYCe 4000 web page
● NYCeCommand
● NYCeConfigurator
● User-developed program
 

NYCe 4000 web page

Fig. 2-6: activate/deactivate CM service on a node via MCU browser page
 
Start the web browser on the PC and enter in the address field the address of
the MCU. Default address is http://192.168.41.14. On the "Home" tab
you can put a checkmark in the checkbox "Activate CM service" to activate
CM service on this node, or remove the checkbox to deactivate CM service
on this node.
If the node is not configured as an LMS node, the checkbox is not available.
 

NYCeCommand With the functions CmActivateCmService and
CmDeactivateCmService you can activate and deactivate CM service on
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the specified node or PC. If the specified node is not a node configured for
LMS, the error SYS_ERR_NOT_SUPPORTED is returned.
 

NYCeConfigurator

Fig. 2-7: activate/deactivate CM service via NYCeConfigurator
 
Select the top item "NYCe4000 System" of the tree in NYCeConfigurator.
Select the tab "CM service". To move CM service to an other MCU or to the
PC, select the device and click the "Apply" button..
The NYCe 4000 system generates a "network changed" event and
synchronizes again in the new configuration, where CM service is active on
the device as displayed in the list on the "CM service" tab.
 

User program With the function CmGetCmServiceActiveDevices you can retrieve all
devices that have CM service running. This includes all nodes and the PC.
With the function CmGetCmServiceActivation you can retrieve whether
the specified node or the PC has CM service activated or deactivated. With
the functions CmActivateCmService and CmDeactivateCmService you
can activate and deactivate CM service on the specified node or the PC.
 
As CM service can be active on the PC and on a node, it is possible that (by
mistake) CM service is active on more than one device in the network.
However, only one CM service is allowed to be active in the system at any
time. You can use NYCeConfigurator to see where CM service is active and
subsequently solve the conflict if two (or more) CM service are active. Note
that CM service is always running on the PC, but only in the active state
when configured to be in the active state.
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LMS client behavior is as follows when more than one CM service is active in
the network.
● LMS clients that are already connected are not influenced.
● LMS clients that try to initialize the system (CmInitialize) receive the

error CM_ERR_DUPLICATE_CM_SERVICE.
If no CM service is active in the network, any LMS client that tries to connect
to CM service via CmConnect receives the error
CM_ERR_CM_SERVICE_NOT_AVAILABLE.
 

2.4.3 Application considerations
Environment dependencies An LMS application can only use system functionality of the environment

where the application is executed. Thus, Windows functionality cannot be
used when the application executes as an Embedded Application on a node.
Vice versa, Linux functionality cannot be used when the application executes
on a PC.
If you use an extension library and CM service is executed on the PC, the
extension library must be built as a DLL. If CM service is executed on a node,
the extension library must be built as a shared object (.so). See "NYCe 4000
LMS Generic PLC Interface Manual" for more information.

Logging All logging of events and data is written to shared memory. The shared
memory is created by CM service. When CM is running on the PC,
NYCeLogger can access the shared memory directly and present the logged
information. When CM service is active on a node, NYCeLogger can access
the information using the CM socket server. To access the logged information
via the CM socket server, you must start NYCeLogger from the command
line with the option /CM or /N.
● With the /CM option, NYCeLogger finds the device where CM service is

active and then retrieves the log information from that device.
● With the /N option, you can specify the IP address of the node which

NYCeLogger must connect to retrieve the logged information. Note that
CM service must be active on the specified node. For example, when
you used the default path of the NYCe 4000 software installation, you
enter C:\Program Files\Rexroth\NYCe4000\amd64\bin
\NYCeLogger /N 192.168.41.14 to start NYCeLogger on the PC
and retrieve log information via the CM socket server running on the
node with the specified IP address.
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3 Carrier Position Adjustment (CPA) tool
3.1 Introduction

When a carrier with a magnet plate moves over a Hall sensor, the position of
the carrier can be determined. However, due to inaccuracies in the
production of a magnet plate, different carriers at the same position above
the same Hall sensor result in slightly different carrier positions. The correct
carrier position can be determined if the difference for that specific carrier is
known.
The Carrier Position Adjustment (CPA) functionality in LMS adjusts the
carrier positions measured by the Hall sensors in the track with the
differences for each carrier position that are stored in a so-called CPA table.
The CPA tool can create the CPA table for each carrier on a track. All CPA
tables are stored in one or more XML files. The XML file(s) can be
downloaded to the Motion Control Unit (MCU). If more than one XML file is
used and a CPA table identifier is used more than once, the last downloaded
CPA table with same identifier is used without a warning. When the CPA
functionality is enabled for a track and CPA tables are assigned to carriers,
the "raw" carrier positions measured by the left, middle and right Hall sensors
are updated, with the adjustment values in the CPA table for this carrier, to
the actual positions.
In this chapter you can find the following information.
● chapter 3.2  "CPA measurement systems" on page 9 describes the

two supported measurement systems.
● chapter 3.3  "NYCeCPATool" on page 12 describes the CPA tool and

the measurement procedures.

The CPA tool does not support the MR sensor; only the Hall
sensor is supported.

3.2 CPA measurement systems
3.2.1 Introduction

The CPA tool uses the NYCe 4000 system to create the CPA tables. The
NYCe 4000 system must consist of a Hall sensor, a magnet plate and an
additional measurement system. The magnet plate and the Hall sensor are
moved in such a way that a profile is measured of the entire magnet plate.
With the external measurement system the position of the Hall sensor relative
to the magnet plate is measured. A NYCe 4000 system is used for the data
acquisition of the Hall sensor and external measurement system. The CPA
tables can be created in off-line and on-line mode. In off-line mode the CPA
tool creates the CPA tables from a NYCe 4000 trace file. The NYCe 4000
trace file is generated with NYCeScope or in a measurement session with
NYCeCPATool. In on-line mode the CPA tool collects the trace data before
the CPA tables are created.
The CPA tool supports two measurement systems.

1. Measurement system 1
consists of at least one NYCe 4000 LMS node and at least one
NYCe 4000 standard node.

2. Measurement system 2
consists of at least one NYCe 4000 standard node. If an LMS node is
present in the system, the LMS node is not used.
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3.2.2 Measurement system 1: two-node (LMS/STD) setup
Measurement system 1 consist of a two-node setup. This setup has (at least)
one NYCe 4000 LMS node and (at least) one NYCe 4000 standard node.
The Hall sensor pair (cosine and sine signal) of one coil are directly
connected to the LMS node.
The reference axis is connected to the encoder input of a NYCe 4000
standard node. This standard node has one or more drive slots. The
reference axis (for example a ruler with an encoder) can be connected to any
axis of any drive module.

coil03coil01coil00 coil02

carriermagnet plate
sensor linear guide with integrated 

measurement system

NYCe4000 network

NY4074 LMS node

1-slot node

Fig. 3-1: Measurement system 1: two-node setup
 
In the CPA tool you select the coil axis (and Hall sensor) of the LMS node
and the reference axis of the NYCe 4000 standard node. The reference axis
type must be defined as SAC_SENSOR_AXIS in NYCeConfigurator, and the
axis resolution and measurement system direction must be correctly
configured.
 

3.2.3 Measurement system 2: one-node (STD) setup
Measurement system 2 consist of a one-node setup. This setup has (at least)
one NYCe 4000 standard node. If LMS node(s) are present in the system,
those LMS nodes are not used. The Hall sensor pair (cosine and sine signal)
of one coil are connected to analog inputs of the NYCe 4000 standard node.
You need an adapter cable from the Hall sensor M8 connector to the analog
input sub-D 9-pin connector, see tab. 3-1 "Adapter cable M8 female / 9-pin
sub-D female" on page 11. The reference axis is connected to the encoder
input of the standard node. This standard node has one or more drive slots.
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The reference axis (for example a ruler with an encoder) can be connected to
any axis of any drive module.

Note that when you connect the Hall sensor to the analog inputs
of a drive module in a standard node, the power supply
connection for the Hall sensor must be wired separately.

coil03coil01coil00 coil02

carriermagnet plate
sensor Linear guide with integrated 

measurement system

1-slot node

NYCe4000 network

+5V / –5V dc
external power supply

adapter cable

Fig. 3-2: Measurement system 2: one-node setup
 

M8 (female) connector
pin number

9-pin sub-D female connector
pin number

Remark

1 1  

2 3  

3 6  

4 9  

5 - External +5V power supply

6 8 GND

7 - External -5V power supply

8 8  

housing shielding cable shielding  

Tab. 3-1: Adapter cable M8 female / 9-pin sub-D female
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In the CPA tool you only select the reference axis (defined as axis type
SAC_SENSOR_AXIS in NYCeConfigurator) of the NYCe 4000 standard node.
 

3.2.4 Requirements
● The Hall sensor which is used to measure the magnetic field of the

magnet plate must be part of a correctly commissioned LMS track (in
measurement system 1).

● Two complete movements are required, one in positive direction and
one in negative direction, to calculate the adjustment values that are
stored in the CPA table.

● The data acquisition must start before the Hall sensor enters the
magnetic field of the magnet plate, and the data acquisition stops after
the Hall sensor leaves the magnetic field of the magnet plate while
moving in the opposite direction.

● The first detected signal when the Hall sensor enters the magnetic field
of the magnet plate when the movement is in the positive direction must
be the cosine signal of the Hall sensor, because the NYCeCPATool
expects this.

● The measurement system must be as similar as possible to the real
system, because the quality of the calculated CPA tables define the
position accuracy of the real system when CPA is used. Therefore, the
distance and material between the Hall sensor and the magnet plate
must be the same.

● The PVL frequency of the reference axis must be set to 8 kHz. Signals
from the multiplexer on the I/O backplane of the NY4074 and NY4079
have a small delay caused by the sample frequency used in the
multiplexer. This PVL frequency setting makes sure that the delays of
the measured signals is identical for all signals.

● The unit of position of the coil axis and the reference axis must be the
same.

● For measurement system 1, the measurement setup must have at least
one NYCe 4000 standard node and at least one NYCe 4000 LMS node
in the network, and the LMS must be initialized. The coil must be
defined on the LMS node, the reference axis must be defined on the
standard node.

● For measurement system 2, the measurement setup must have at least
one NYCe 4000 standard node. The reference axis is defined on this
node. The cosine signal of the Hall sensor must be connected to analog
input 0 of the used slot, and the sine signal of the Hall sensor must be
connected to analog input 1 of the used slot. The voltage level of the
cosine and sine signals must be at least 10 Vtt (+/-5 V symmetrical).
With this requirement the calibration process in both measurement
systems is consistent. Note that the maximum analog input range of a
drive module is +/-10 V.

3.3 NYCeCPATool
3.3.1 Introduction

The NYCeCPATool window appears when you start NYCeCPATool.
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Fig. 3-3: Main dialog window of NYCeCPATool
 
The menu bar of the NYCeCPATool window has two entries, "File" and
"Help". At the bottom of the NYCeCPATool window is status information
displayed.
The drop down list of the "File" entry has the following entries.
● New CPA Table...

This selection creates a new CPA table using data from a calibration
system. Appropriate data must be entered in the "Calibration system"
section.

● Open Trace File...
This selection creates a CPA table from a trace file. The selected trace
file name is displayed in the status bar.

● Save CPA File
This selection saves all CPA tables to the opened CPA file. All previous
contents of the opened CPA file is erased.

● Save CPA File As...
This selection saves all CPA tables to the CPA file specified in the
"Save As..." dialog window. If the specified file exists, all previous
contents of the file is erased.

● Open CPA File...
This selection shows the contents of a CPA table. The selected CPA file
name is displayed in the status bar.

● Exit
This selection terminates the NYCeCPATool. An active calibration
process and data collection process is aborted. If applicable, a warning
is displayed that there is not-saved CPA parameter data and/or not-
saved trace data.

The drop down list of the "Help" entry only has the "About NYCeCPATool"
entry. When this selection is chosen, the "About NYCeCPATool" dialog
window appears. This window shows the NYCe 4000 version information.
The status fields at the bottom of the "NYCeCPATool" main window show the
information:
● Operation information
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– "Idle", when the tool is started
– "View", when displaying a CPA table from an opened CPA file
– "Create", when creating a CPA table using a calibration system or

trace file.
● CPA file name if a CPA file is opened
● A field that indicates how trace data is collected

– Axis name, axis state and trace state if data is collected from a
calibration system

– Trace file name if data is collected from a trace file.
● Activity field

Some operations of the NYCeCPATool require time to complete.
Feedback about the activity is given with a busy indicator. Time-
consuming operations are reading and writing a trace file or CPA table
file, and the data collection and calibration process.

 

3.3.2 Create CPA table using data from a calibration system
In the on-line mode you can create the CPA table(s) from data collected from
both measurement systems.
After you select "File → New CPA Table...", the "Calibration system" dialog
window appears.

Fig. 3-4: Calibration system dialog window
 
Depending on the filled entry fields in the "Calibration system" dialog window
the measurement system to be used is selected.
● Coil axis and Reference axis specified

Fig. 3-5: Measurement system 1 - coil axis and reference axis selected
 
If you select a coil axis and a reference axis, measurement system 1 is
used. The only other entry field that must contain information is which
sensor of the coil is used for the measurement. The coil axis is used to
capture the coil sensor data during the data collection process. Note
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that the coil axis is only available after the LMS is initialized. No
additional information for the reference axis is needed.

● Reference axis only specified

Fig. 3-6: Measurement system 2 - only reference axis selected
 
If you only select a reference axis, measurement system 2 is used. In
this case you must specify values for the sensor detect criteria and
sensor detect hysteresis. These values are part of the configuration of
the LMS sensors. You can see appropriate values with the
NYCeLmsCommissioning tool. For each sensor of every coil, see the
"Sensor detect criterion" and "Sensor detect hysteresis" entry.

If the appropriate fields contain data, the "OK" button in the "Calibration
system" dialog window is enabled, else the "OK" button is disabled. If the
"Calibration system" dialog window is closed with the "OK" button the
selected axis names are shown in the status fields of the NYCeCPATool
window. The NYCeCPATool window displays the following sections.
● "CPA Table"
● "Data collection"
● "System"

Fig. 3-7: NYCeCPATool ready to capture data from the measurement system
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CPA table field Explanation

Table Id CPA table identifier.
This is an integer number between 0 and
CM_MAX_NR_OF_CPA_TABLES.

User data Free format text string to identify unambiguously the magnet
plate to which this CPA table belongs. You must enter some
text in this field.

Step size Parameter step size specified in pu, and defines the number
of measurement points in the CPA table.
Note that the value for this parameter depends on LMS
components such as the magnet plate.
Step size =
(length magnet plate - ½ pole pitch) / (number of points - 1)

Number of adj Number of position adjustments in the CPA table.
This is an odd number, the maximum value is
CM_MAX_NR_OF_CPA_VALUES.
This edit box is always read-only, because the parameter
value is determined by the calibration process. See "Step
size".

Interpolation factor Parameter interpolation factor, specifies the number of
increments per quarter of the pole pitch. The initial value for
this parameter is read from the LMS configuration file.

Resolution Parameter resolution specified in inc/pu. The initial value for
this parameter is read from the LMS configuration file.

Sensor orientation Sensor orientation, the value can be "negative" or "positive".
This edit box is always read-only, because this parameter is
determined by the calibration process. Note that it is possible
that the initial value is wrong, but the value is correct after the
measurement is completed.

Tab. 3-2: The fields of the "CPA table" dialog window
 
You must enter a number for the CPA table identifier and a text to
unambiguously describe for which magnet plate this CPA table is generated.
The step size, interpolation factor and resolution are set to default values and
can be changed to match the system parameters. The values in the read-only
fields "Number of adj" and "Sensor orientation" are determined by the data
collection and calibration process.
If you click the "Cancel" button, changed values of the CPA parameters are
discarded and the previous values are displayed.
If you click the "Apply" button, a new CPA table for the specified table
identifier is created. The created CPA table does not contain any
measurement data, because the data collection and calibration process has
not yet been executed.
The "Trace time" field specifies how long trace data is collected. If the trace is
still active when the specified time has elapsed, the trace is stopped and an
error message is displayed.
When you click the "Start" button the data collection from a calibration system
is started. The "Finish" and "Abort" buttons are enabled, and the "Start" and
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"Save..." buttons are disabled. Click the "Finish" button when the movements
are completed and the data collection can be stopped.
The required movements, one movement in the positive direction and then
one movement in the negative direction can be done manually, if possible.
Note that for each movement the magnet plate must be outside the detection
range of the Hall sensor, and be moved over the Hall sensor until the magnet
plate is again outside the range of the Hall sensor at the other side.

Fig. 3-8: NYCeCPATool capturing measurement data
 
After you clicked the "Finish" button the calibration process is started. When
the calibration process has completed the "Start" and "Save..." buttons are
enabled and the "Abort" and "Finish" buttons are disabled.
Click the "Save..." button to save the collected trace data in a file. The "Open"
dialog window appears and you can specify a file name for the trace data.
Note that NYCeCPATool appends a time stamp to the file name that you
specify. As you will most likely do more than one measurement, because the
track consists of more than one carrier, you can click the "Save..." button
after each data collection and calibration process without changing the file
name. The file name is unique because of the appended time stamp.
You can click the "Abort" button to stop the data collection. The calibration
process is not started.
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Fig. 3-9: NYCeCPATool measurement data processing finished
 
Three graphs for the CPA parameters adjustment are displayed. The three
graphs show data from the movement in the positive direction, the movement
in the negative direction, and one graph shows the averaged values. You can
remove and add the names of the three graphs with the checkbox "Show
data name" in the "CPA Table" section. The scale of the X-axis and Y-axis is
pu. The position of consecutive adjustments is calculated with the parameter
step size. The carrier position when the middle of the magnet plate is right
above the Hall sensor is marked with "0" on the X-axis. Using the mouse, you
can draw a "rectangle" to magnify a specific area of the graph (zoom-in
functionality). Double-clicking the left mouse button while the mouse pointer
is in the graph shows the original graph again. If the mouse is hovered over a
graph, the actual adjustment value and position are displayed.
The "System" dialog window displays the values of system parameters, and
allows a change of them.
The field "MS number of periods" displays the initial value taken from the
CPA tool settings. MS stands for "Measurement System". You can change
this value. The value is used in the calibration process, and must be specified
before the data collection and calibration process is started.
The field "Resolution" displays the value of the parameter resolution of the
coil axis, if present, else the field displays the parameter resolution of the
reference axis.

You can still make changes to the enabled fields in the "CPA
Table" section. Click the "Apply" button to save the changes, or
click the "Cancel" button to discard any changes you made.

Select the menu bar entry "File → Save CPA File" or "File → Save CPA File
As..." after you have executed the described procedure for all magnet plates
(carriers) in the track. The CPA file, containing a CPA table for every magnet
plate, is saved. The file name is "untitled.xml" if you select "Save CPA File". If
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you select "Save CPA File As..." the "Save" dialog window appears and you
can specify a file name.
After the calculated differences are stored, the NYCeCPATool can only show
these calculated differences, the graph only shows these values.
 

3.3.3 Create CPA table using data from a trace file
In the off-line mode you can create the CPA table from trace files that are
saved during previous measurements, or from data collected and stored with
NYCeScope.
Select the following variables in NYCeScope for measurement system 1.
● Channel 1 - SAC_VAR_AXIS_POS of the reference axis
● Channel 2 - SAC_VAR_LMS_LEFT_SENSOR_ANGLE of selected coil
● Channel 3 - SAC_VAR_LMS_LEFT_SENSOR_COS of selected coil
● Channel 4 - SAC_VAR_LMS_LEFT_SENSOR_POSITION of selected coil
● Channel 5 - SAC_VAR_LMS_LEFT_SENSOR_SIN of selected coil
● Channel 6 - SAC_VAR_LMS_LEFT_SENSOR_STATUS of selected coil
Note: the selected "LEFT_SENSOR" variables can also be "MIDDLE_SENSOR"
or "RIGHT_SENSOR", depending on the sensor that is used.
 
Select the following variables in NYCeScope for measurement system 2.
● Channel 1 - SAC_VAR_AXIS_POS of the reference axis
● Channel 2 - NHI_VAR_AN_IN0_VALUE_SLOT0 for the cosine signal of

the Hall sensor
● Channel 3 - NHI_VAR_AN_IN1_VALUE_SLOT0 for the sine signal of the

Hall sensor
Note: the selected slot number "0" can also be 1, 2, 3, 4, or 5, depending on
the slot where the reference axis is configured.
 
After you select "File → Open Trace File..." and selected a valid trace file in
the "Open" dialog window, the NYCeCPATool window displays the following
sections.
● "CPA Table"
● "Data collection"
● "System"
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Fig. 3-10: NYCeCPATool window after opening a trace file
 
The "CPA Table" section shows the value of the CPA parameters, see tab.
3-2 "The fields of the "CPA table" dialog window" on page 16.
You must enter a number for the CPA table identifier and a text to
unambiguously describe for which magnet plate this CPA table is generated.
The step size, interpolation factor and resolution are set to default values and
can be changed. The values in the read-only fields "Number of adj" and
"Sensor orientation" are determined by the data collection and calibration
process.
If you click the "Cancel" button the changed values of the CPA parameters
are discarded and the previous values are displayed.
If you click the "Apply" button, a new CPA table for the specified table
identifier is created. The value for the field "Number of adj" is set to zero,
because the trace file has not yet been processed. The "Sensor orientation"
is initialized to "Negative". Repeat this for all magnet plates for which you
want to create CPA tables.
If you click the "Start" button in the "Data collection" section, the data
collection and calibration process starts if the trace data is collected with
measurement system 1. If the trace data is collected with measurement
system 2, you must first enter appropriate values in the "Calibration system"
dialog box that appears.
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Fig. 3-11: Measurement system 2: specify sensor detect criteria and hysteresis
 
Click the "OK" button.
The "Trace time" field shows the amount of time for which data is stored in
the trace file. A new CPA table for the specified table identifier is created, just
like the action after you click the "Apply" button, but in this case the CPA
table contents is generated and the value for the field "Number of adj" is set
to the actual number of measurements after the data collection and
calibration process is finished.

Fig. 3-12: The result of processing a trace file
 
Three graphs for the CPA parameters adjustment are displayed. The three
graphs show data from the movement in the positive direction, the movement
in the negative direction, and one graph shows the averaged values. You can
remove and add the names of the three graphs with the checkbox "Show
data name" in the "CPA Table" section. The scale of the X-axis and Y-axis is
pu. The position of consecutive adjustments is calculated with the parameter
step size. The carrier position when the middle of the magnet plate is right
above the Hall sensor is marked with "0" on the X-axis. Using the mouse, you
can draw a "rectangle" to magnify a specific area of the graph (zoom-in
functionality). Double-clicking the left mouse button while the mouse pointer
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is in the graph shows the original graph again. If the mouse is hovered over a
graph, the actual adjustment value and position are displayed.
At this point you can still make changes to the parameters in the "CPA Table"
section. If you click the "Cancel" button in the "CPA Table" section, the
changes are discarded and the previous values before the data collection
and calibration process are used. If you click the "Apply" button in the "CPA
Table" section, the changed values are accepted. A message is displayed if
the opened CPA file already contains a CPA table with the same table
identifier.
The field "MS number of periods" in the "System" section displays the initial
value taken from the CPA tool settings. You can change this value. The value
is used in the calibration process, and must be specified before the data
collection and calibration process is started. If the value in the field "MS
number of periods" in the "System" section is not equal to the value derived
from the trace data, the mismatch is reported.
Repeat the described procedure to create a CPA table from a trace file of
every magnet plate in the track.
When you click the "Save..." button in the "Data collection" section, you can
store the trace data in a file.
With the menu bar selections "File → Save CPA File" and "File → Save CPA
File as..." you can store the calculated differences for each position for every
CPA table in a CPA XML file. The file name is "untitled.xml" if you select
"Save CPA File". If you select "Save CPA File As..." the "Save" dialog
window appears and you can specify a file name.
After the calculated differences are stored, the NYCeCPATool can only show
these calculated differences, the graph only shows these values.
 

3.3.4 View CPA table XML file data
Click the menu bar selection "File → Open CPA File..." to view the CPA XML
file data. The "Open" dialog box appears. After you specify a valid XML CPA
file, the NYCeCPATool displays the data.
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Fig. 3-13: Viewing XML CPA table data
 
You can select the CPA table identifier with the drop down box in the "Table
Id" field. The graph shows the calculated values from the selected CPA table.
You can change the values in the fields "User data", "Step size",
"Interpolation factor", and "Resolution". Click the "Cancel" button in the "CPA
Table" section to discard the changes. Click the "Apply" button in the "CPA
Table" section to accept the changes.
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4 NYCeCmMonitor
NYCeCmMonitor is a tool that provides a quick overview of the status of the
LMS.

NYCeCmMonitor can only run on a PC. However, CM service
may be active on the PC or on any node.

The tool shows the following information.
● The LMS system state.

The "NumberOfCarriers" column always shows a number that indicates
the number of carriers that have an assigned identifier. Further, this
column displays a number between brackets that indicates the number
of carriers that do not have an assigned identifier. This number is only
displayed if it is not 0.

● The tracks in the LMS.
The information of not configured tracks is indicated by minus signs.

● The carriers in the LMS.
Carrier identifiers are listed in ascending order. The information of
carriers that have no identifier assigned is indicated by minus signs.

Fig. 4-1: NYCeCmMonitor
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Notes
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